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	SI* (MODERN METRIC) CONVERSION FACTORS

	APPROXIMATE CONVERSIONS TO SI UNITS
	APPROXIMATE CONVERSIONS FROM SI UNITS

	Symbol
	When You Know
	Multiply By
	To Find
	Symbol
	Symbol
	When You Know
	Multiply By
	To Find
	Symbol

	LENGTH
	LENGTH

	  in
	inches
	25.4
	millimeters
	mm
	  mm
	millimeters
	0.039
	inches
	in

	  ft
	feet
	0.305
	meters
	m
	  m
	meters
	3.28
	feet
	ft

	  yd
	yards
	0.914
	meters
	m
	  m
	meters
	1.09
	yards
	yd

	  mi
	miles
	1.61
	kilometers
	km
	  km
	kilometers
	0.621
	miles
	mi

	AREA
	AREA

	  in2
	square inches
	645.2
	millimeters squared
	mm2
	  mm2
	millimeters squared
	0.0016
	square inches
	in2

	  ft2
	square feet
	0.093
	meters squared
	m2
	  m2
	meters squared
	10.764
	square feet
	ft2

	  yd2
	square yards
	0.836
	meters squared
	m2
	  ha
	hectares
	2.47
	acres
	ac

	  ac
	acres
	0.405
	hectares
	ha
	  km2
	kilometers squared
	0.386
	square miles
	mi2

	  mi2
	square miles
	2.59
	kilometers squared
	km2
	VOLUME

	VOLUME
	  mL
	milliliters
	0.034
	fluid ounces
	fl oz

	  fl oz
	fluid ounces
	29.57
	milliliters
	mL
	  L
	liters
	0.264
	gallons
	gal

	  gal
	gallons
	3.785
	liters
	L
	  m3
	meters cubed
	35.315
	cubic feet
	ft3

	  ft3
	cubic feet
	0.028
	meters cubed
	m3
	  m3
	meters cubed
	1.308
	cubic yards
	yd3

	  yd3
	cubic yards
	0.765
	meters cubed
	m3
	MASS

	NOTE: Volumes greater than 1000 L shall be shown in m3.
	  g
	grams
	0.035
	ounces
	oz

	MASS
	  kg  
	kilograms
	2.205
	pounds
	lb

	  oz
	ounces
	28.35
	grams
	g
	  Mg
	megagrams
	1.102
	short tons (2000 lb)
	T

	  lb
	pounds
	0.454
	kilograms
	kg
	TEMPERATURE (exact)  

	  T
	short tons (2000 lb)
	0.907
	megagrams
	Mg
	  C
	Celsius temperature
	1.8 + 32
	Fahrenheit
	F

	TEMPERATURE (exact)
	jan

	  F
	Fahrenheit temperature
	5(F-32)/9
	Celsius temperature
	C
	

	
	

	* SI is the symbol for the International System of Measurement
(4-7-94 jbp)
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1.0 general format

1.1 paper size

Reports will be on 8.5 x 11 inch paper.  Reports will be printed double sided.  Proof copy may be single sided.

1.2 margins

1.2.1 Left/Right/Bottom Margins

Left, right, and bottom margins should always be set at 1 inch.  Use Page Setup to change the default margins if necessary.

1.2.2 Top Margins

1.2.2.1 Cover Page and Appendix Title Pages

The cover page will have a top margin of 2.5 inches.  Appendix title pages will have top margins of 4 inches.

1.2.2.2 Chapter Headings 

The top margin will be 1.5 inches on pages with chapter headings.

1.2.2.3 Other Pages

The top margin will be 1 inch on all other pages.  

1.2.2.4 Instructions

If an electronic version of this document is used as a template, the style “Heading 1” will automatically place the chapter heading at 1.5” from the top of the page, provided the margin is set at 1”.  Otherwise, in order to change the margin size from one page to another, a section break must be inserted between the two pages.  For example, at the bottom of a chapter heading page, choose Break from the Insert menu, then select Next Page under Section Break and click OK.  This will allow a different top margin size on the next page without interrupting the flow of the report.  

1.3 heading and body text format 

If this document is used as a template, the heading and text formats are already set up in the Style drop-down menu (underneath the New, Open, and Save icons on the toolbar).  See Table 1.1 for a list of styles to apply to various levels of the report.

Table 1.1: Style and heading index

	STYLE
	LEVEL
	NUMBERING

	TITLE 
	Report title, Appendix title(s)
	None

	Heading 1
	Chapter Headings (Level 1)
	1.0 – X.0

	Heading 2
	Level 2
	X.1 – X.X

	Heading 3
	Level 3
	X.X.1 – X.X.X

	Heading 4
	Level 4
	X.X.X.1 – X.X.X.X

	Heading 5
	Level 5
	X.X.X.X.1 – X.X.X.X.X

	Body Text (1,2,3)
	Text immediately after Headings 1, 2, and 3 
	None

	Body Text 2
	Text immediately after Heading 4
	None

	Body Text 3
	Text immediately after Heading 5
	None


All text is Times New Roman font.  If this document is used as a printed style manual, the following outlines the formatting and numbering to be applied to different heading levels of the report.  

Table 1.2: Heading and text formatting rules

	STYLE
	LEVEL
	NUMBERING

	Report title, Appendix title(s)
	16 pt. Bold, centered, all caps, 1/2 inch tab, 24 pts. of space before and after.
	None

	Chapter headings
	16 pt. Bold, centered, all caps, 1/2 inch tab, 36 pts. of space before, 24 pts. of after.
	1.0 – X.0

	Level 2 subtitles
	14 pt. Bold, all caps, 1/2 inch tab, 12 pts. of space before and after.
	X.1 – X.X

	Level 3 Subtitles
	14 pt. Bold, Title Case, 1/2 inch tab, 12 pts. of space after.
	X.X.1 – X.X.X

	Level 4 Subtitles
	12 pt. Bold italic, title case, 3/4 inch tab, ½ inch indent, 12 pts. of space after.
	X.X.X.1 – X.X.X.X

	Level 5 Subtitles
	12 pt. italic, Title Case, 1 inch tab, 1 inch indent, 12 pts. of space after.
	X.X.X.X.1 – X.X.X.X.X

	Body text after Chapter Headings and Levels 2 and 3
	12 pt., left justification, 12 pts. of space after.
	None

	Body text after Level 4
	12 pt., ½ inch indent, left justification, 12 pts. of space after
	None

	Body text after Level 5
	12 pt., 1 inch indent, left justification, 12 pts. of space after
	None

	Table Title
	10 pt. Bold, Title case, left justified
	chapter.1 – X.X

	Figure heading
	10 pt., Title case, centered, 12 pts. of space before, 36 pts. of space after
	chapter.1 – X.X


The following page shows how the formats and numbering should appear.

2.0 How to Play mah jongg

Mah Jongg is an ancient and fascinating game of chance and skill.

2.1 Setting up the tiles

The first thing you have to do is set up all 164 tiles, following the procedures below.  Make sure you follow them exactly, or the great Goddess of Tiles will ruin your fun!

2.1.1 Shuffling

Place all tiles face down and everyone swirl the tiles around the table until they are completely shuffled.

2.2 Building the Wall

Each player should build a wall in front of their playing rack, two tiles high, two tiles deep, and 21 tiles long, with tiles positioned at right angle to the rack.

2.3 Dealing

Before the game can begin, each player must receive tiles to work with.  “East” deals out the tiles.

2.3.1 Choosing “East”

The first player to play in the “East” position can be selected in a number of ways.  No matter how this is decided, “East”, or dealer, rotates to the left after each game.

2.3.1.1 Directional

Using this option, the person who is actually sitting easternmost will be East first.

2.3.1.2 Dice

The player rolling the highest number on one roll of one die is East.

2.3.1.2.1 Other dice options

Any rule can be used with dice, so long as it is agreed upon by all players.  For example, 2 dice may be used, and the person with the lowest total could be East.

2.4 paragraph format

All paragraphs shall be left justified, single spaced, and indented the same as the appropriate heading.  For example, paragraphs under a Level 4 heading will be indented 0.5” from left margin.

2.5 page numbering 

2.5.1 Position

Page numbers will be centered within the footer, ½ inch from the bottom of the page.  All page numbers will be in 12 pt. Times New Roman font.
2.5.2 Numbering, Sequence and Style

2.5.2.1 Blank Pages

Blank pages, such as blank left-facing (even) pages before new chapters, should be numbered.  Inserting a Page Break (Insert Menu) will create numbered even pages as needed.

2.5.2.2 Title Pages

The front cover page (see Sec. 2.1) will not be numbered.  Subsequent title pages (see Section 2.0) shall be numbered sequentially, using lower case roman numerals (i.e. i, ii, iii, iv...), starting with the Technical Documentation Report page through to the first page of the body of the report.  

2.5.2.3 Chapters

Chapters shall begin on odd numbered pages on the right-facing page. 
2.5.2.4 Main Body and References

The main body of the report, including References, shall be numbered sequentially, using Arabic numerals (i.e. 1,2,3...), starting with the first page of the body of the report.

2.5.2.5 Appendices

Appendices are to be numbered sequentially using the format “A-1”.  The appendix title page is not numbered.  Page numbering begins with the body of the Appendix on the right-facing page and is continuous throughout, including tables, graphs, figures, etc.

3.0 title pages

Title pages are all pages from the front cover up to the first page of the main body.

3.1 front cover

Conforms to ODOT Research Unit requirements.  See front cover of this report for an example.  The front cover is not numbered.  Begin the title of the report 2.5 inches from top.  Title should be centered and in 16 pt. bold or larger, as space allows.

3.2 technical report documentation page. (Page i)

3.2.1 Federal Studies and SPR-funded State Studies

use fhwa form dot f 1700.7 for all fhwa or usdot sponsored reports.  This form may be electronically copied from this document.  See sample located on page i of this report.

3.2.2 State Studies

Use the above form or a similar substitute.

3.3 METRIC CONVERSION FACTORS (Page ii)

The conversion factors table may be electronically copied from this document.  For ODOT employees, the form can be imported into your document from




 “\\S-SALEMGEOM-1\6531shar\_Report_Specs\metric.doc.”  See sample located on page ii of this report.

3.4 ACKNOWLEDGMENTS (Page iii)

If possible the ‘ACKNOWLEDGMENTS’ should share the same page as the Disclaimer.  The word ‘ACKNOWLEDGMENTS’ should be 16 point, bold, all caps and centered.  The text shall be flush with the left margin, using the same style as the main body text (12 pt Times New Roman).

3.5 disclaimer (Page iii)

The word ‘DISCLAIMER’ should be 16 point, bold, all caps and centered.  The text shall be flush with the left margin, using the same style as the main body text (12 point, Times New Roman).  

Please use the combined ODOT/OTREC Disclaimer:
The contents of this report reflect the views of the authors, who are solely responsible for the facts and the accuracy of the material and information presented herein.  This document is disseminated under the sponsorship of the U.S. Department of Transportation University Transportation Centers Program and [OREGON DEPARTMENT OF TRANSPORTATION or UNIVERSITY or other SPONSER/PARTNER] in the interest of information exchange.  The U.S. Government and the [OREGON DEPARTMENT OF TRANSPORTATION or UNIVERSITY or other SPONSOR/PARTNER] assume no liability for the contents or use thereof.  The contents do not necessarily reflect the official views of the U.S. Government or [OREGON DEPARTMENT OF TRANSPORTATION or UNIVERSITY or other SPONSOR/PARTNER]. This report does not constitute a standard, specification, or regulation.
3.5.1 State Reports (with No Federal Funding)

Please use combined ODOT/OTREC Disclaimer

3.5.2 Usdot & Fhwa Reports

Please use combined ODOT/OTREC Disclaimer
3.6 table of contents (Page v)

3.6.1 Title

The title of the report is 14 pt, bold, all caps, centered at the top (1” margin) of the first page of the Table of Contents and on an odd (right facing) page.  Insert a section break if needed.

The words “TABLE OF CONTENTS” in 16 pt., bold, all caps, are centered 24 pts. below the report title.  Leave 24 pts. of space between the words “TABLE OF CONTENTS” and the first entry.  See page v of this report for example.

3.6.2 Format

Do not attempt to generate the Table of Contents until all of the chapter headings and subheadings have the correct “Heading” styles applied to them.  If this document is used as a template, creating a Table of Contents is very simple.  Just position the pointer anywhere within the existing Table of Contents, right click the mouse, and select “Update field”.  Then choose “Update entire table”. This should automatically generate a Table of Contents with the correct formatting.

Otherwise, the Table of Contents should be generated with the Table of Contents template.  The first step is to create a Table of Contents page.  Once all of the chapter headings and subheadings have the correct styles applied, go to the line 24 pts below the words “TABLE OF CONTENTS”.  From the “Insert” menu, choose “Reference”, then “Index and Tables…”, and select the “Table of Contents” tab.  Uncheck the Hyperlinks box; then click “OK”.  

See page v for an example.

3.6.3 References

The reference section is usually the last item in the Table of Contents and formatted the same as chapter headings (Heading 1).

3.6.4 Appendices

A list of Appendices follows the Table of Contents.  The format is similar to the Table of Contents.  See example on page vi.

3.7 list of tables 

3.7.1 Title

The words ‘list of tables’ is 14 pt, bold, all caps, centered and follows the Appendices in the Table of Contents.  The format is similar to the Table of Contents above.  See example on page vi.

3.7.2 Format

The words ‘Table 1’ are to be flush left, the page numbers are to be flush right, and there should be a dotted line leader between the table titles and page numbers.  Font is to be 12 pt bold.  See sample on page vii.
3.8 list of figures/photos 

3.8.1 Title

The words ‘list of figures (photos)’ in 14 pt, bold, are centered following the List of Tables.  The format is similar to the List of Tables.

3.8.2 Format

The words ‘Figure 1’ are to be flush left, the page numbers are to be flush right, and there should be a dotted line leader between the figure titles and page numbers.  Font is to be 12 pt, not bold. See sample on page vii.
3.9 EXECUTIVE SUMMARY

The executive summary should follow the general format of the report, except that the headings will not be numbered.  Begin on the first odd, right-facing page after the Table of Contents.  Page numbers will be Arabic numerals.

An executive summary is required for joint OTREC reports and should preview the main points of the report, while being no more than a page or two in length.  The summary should contain enough information for a reader to get familiarized with what is discussed in the full report.  Summary points should be listed in the same order they appear in the main report, including any conclusions or recommendations.  Graphics, photos and other illustrations may be used.  
Numbered sections following the Executive Summary should include a complete description of the project’s problem/background, approach, methodology, findings, conclusions, recommendations, etc.  The report should completely document all data gathered, analyses performed and results achieved.  References must be correctly cited (see Section 6.0).  Photos, tables and figures that help illustrate report points are encouraged.  
Researchers may also include a technology transfer plan for the research results, and are encouraged to discuss the project in regard to how it relates to USDOT objectives, priorities and/or critical issues.  

4.0 tables

4.1 font

The title of the table will be in Times New Roman, 10 pt bold, Title Case.  The contents of the table will be in Times New Roman 10 pt (not bold).

4.2 format

Refer to The Chicago Manual of Style.  See below for general format.


Table 4.1: Steps for inserting a table

	STEP#
	CHOOSE/SELECT
	FROM
	TO GET

	1
	“Insert Table”
	“Table” Menu 
	Table size

	2
	# of columns and rows desired
	Popup window
	Correct # of columns and rows

	3
	“Borders and Shading…”
	“Format” Menu
	“Borders” tab

	4
	“Borders” tab
	Popup window
	Border/grid design tools

	5
	“Grid”
	“Setting”
	Correct top/bottom border and gridline weights

	6
	Left and right sides 
	Preview picture
	No grid or border lines on sides of table


4.3 setup

Follow the steps in Table 4.1 to insert a table.

4.4 numbering

Tables shall be sequentially numbered throughout the report.  The format shall be “Table (Chapter#).(# of table within Chapter): Description or Title”.  
4.5 LOCATION

Tables should be on the same page as the text reference whenever possible.
5.0 figures and photos

5.1 caption

The caption font for figures and photos is Times New Roman 10 pt., sentence case, centered below the figure/photo. Do not bold.  (The style is “Figure.”)  An example of a figure caption is shown below in Figure 5.1.
5.2 SETUP
Figures and photos should be provided in files separate from the research document.  The name of the file should correspond to the number and title of the figure.  The location of the figure in the document may be indicated by placement of a non-floating empty rectangle and the Figure Number and Title in the desired location.  

Photo files and drawings should be provided in JPEG (.jpg) format if at all possible.  Drawings may also be provided as separate Microsoft Word documents.

Graphs and charts should be provided as Microsoft Excel files if at all possible.

Authors should make every effort to produce graphic illustrations which do not rely on color printing to be understood.  Due to the expense of color printing, research reports will not printed with color pages unless the use of color is essential to the presentation of the information in the report.  Thus, charts and graphs should employ the necessary shading and/or texture to distinguish one data series from another.  Photos and drawings should be clearly comprehensible in black and white, employing labels if necessary to identify elements the reader should notice.

[image: image1.png]\‘SIEA, RCH.




Figure 5.1: Sample figure

If a hard copy of a figure or photo is to be physically pasted to the correct spot in the report, use the table feature to prepare the location.  Insert a “table” with 1 row and 1 column.  Click and drag as needed to make the area the finished size for the photo or illustration.  Using the “Borders and Shading…” feature on the Format menu, give the area a single line border and 5% shading. Number the photos and figures on the back, and place the corresponding number in the box.  Figure 5.2 shows an example of how an area prepared for a figure should look.

	1


Figure 5.2: Sample of area prepared for hard copy of figure or photo

5.3 numbering

Figures and photos shall be sequentially numbered throughout the document.  The format shall be as follows: 

Figure [Chapter#].[# of figure within Chapter]: Description or Title

Figures and photos should be located as close to the text reference as possible.

6.0 EQUATIONS

6.1 FORMAT

The equation is centered and bolded.  The equations are numbered sequentially within each Chapter (i.e. “(6-1)”) and the equation number is flush right.  The discussion of the equation follows the equation.  See below for example.

6.2 DIRECTIONS

Equations are created by selecting “Insert” and then “Object”.  Select “Equation 1.0/2.0/3.0”.    A tool bar will appear with equation symbols.  Select the appropriate symbol and create the equation.  See example below.
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(6-1)

The text discussing the equation is placed here.

7.0 references

References shall include only published works.

7.1 format

7.1.1 Title

‘references’ in 16 point, bold, centered horizontally on an odd numbered page, insert a blank page if needed.  Leave two blank lines between the title and the first entry.  Double space between entries.  

7.1.2 Ordering

References shall be alphabetized by last name of author.  

7.2 font

Times New Roman 12 point.

7.3 citation format

When a reference is cited in the text, it shall be italicized and in parentheses in the text only, using the following format: (lastname year).  

Refer to The Chicago Manual of Style for formatting of each type of publication.

The following are examples of acceptable formats:

T. Matsui, K.C. Son, T. Amano, Y. Otani, and K. Hayashi.  “Scase Histories on Reinforced Cut Slopes Due to Root Piles in Osaka.”  International Symposium on Soil Reinforcements:  Full Scale Experiments of the 80’s.  Paris, France.  November 1993.

H. Schnable, Jr.  Tiebacks in Foundation Engineering and Construction.  McGraw-Hill, Inc. 1982.

T.D. Wentworth.  “Distribution of Axial Forces in Soil Nails Based on Interpretation of Measured Strains.”  Masters Thesis.  University of Washington at Seattle, Washington. 1994.

8.0 appendices

8.1 title page

8.1.1 Format

‘appendix a’ in 16 pt, bold, centered vertically and horizontally on the title page which must be a right facing page.  Insert section breaks if needed.  See example below.

Appendix a

example of appendix title page

8.1.2 Numbering

Appendices are to be individually numbered sequentially using the format “A-1”.  The title page is unnumbered.  Page numbering begins with the body of the Appendix on a right facing page and is continuous throughout including tables, graphs, figures, etc.  

8.2 format

The body of the appendix shall follow the same format as the main body of the document and shall begin on an odd page number (the right hand page of a pair).  Insert a section break as appropriate.  Any tables or figures in the appendices may be individually numbered but are not required to be.
9.0 ODOT check list (for research unit use only)

When a report is ready for publication, complete the following forms:

	
	· checklist

	
	· user survey

	
	· dist.list

	
	spr

	
	fhwa

	
	state

	
	ef

	
	· cover letter


These forms are located in
“\\S-SALEMGEOM-1\crew6531\6531only\_Procedures_Manual\Appendix_E--Publishing”.  

Note:  The checklist is completed as you proofread the report and prepare it for a double-sided proof copy.  The proof copy thermal bound with a cover sheet and proofed to ensure blank pages are properly placed and that chapters start on odd pages.
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 Interim or Final Report?  Time span of study





1.5 Pt





OTREC Report series number (to be assigned by OTREC)


16 Point, Bold, Title Case





0.75 Pt





0.75 Pt











ODOT Project type and number goes here





Same as date on the Title page (month and year of publication)





Contact ODOT Research to retrieve sequential report number. The format is:  (FHWA)-OR-(RD)-fiscal yr-##. 


Also include OTREC report series number (to be assigned by OTREC.  The format is OTREC-RR-08-01











Put month and year of publication here





Include OTREC name and address 











Put Author(s) and University here this and remaining text are all 12 point, Title case





Put ODOT Project Type and Number HERE


16 Point, Bold, Title Case





PUT SUBTITLE HERE     16 POINT BOLD, ALL CAPS





put Title Here


Title is 18 point, BoLD, All caps








Notes from the author 


(if any)





This should say “Copies available from NTIS and online at http://www.oregon.gov//ODOT/TD/TP_RES/” for SPR reports.  For state funded reports, omit the reference to NTIS.  Can also list www.otrec.us





List the organization(s) contracting/ funding project 





Typically “unclassified” 





Insert key words to help others find the subject of the document





Total number of pages (front and back) from the front to back cover








OTREC Report series number (to be assigned by OTREC)


16 Point, Bold





put report type Here


(construction, INTERIM, final, etc.)


16 Point, Bold, Title Case








put report type Here


(construction, INTERIM, final, etc.)


Font is title case and is 18-28 point (1-2 sizes smaller than title font) 








put Title Here


Title is 22-36 POINT, All caps


Title should be on 1-2 lines








Include ODOT Research Unit name and address 
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